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Hyperion Essbase 
Release 6.1 
Installation and Migration
Congratulations on receiving Hyperion® Essbase® Release 6.1. 

This booklet contains information on:

● Installing and migrating, including a plan for migrating calc scripts, report scripts, 
ESSCMD scripts, MaxL scripts, and API programs.

● Platform support and hardware requirements.

For information on Hyperion Essbase Release 6.1 new features and documentation, 
see the Hyperion Essbase New Features booklet.
●1Hyperion Essbase Release 6.1 Start Here



●2 Hyperion Essbase Release 6.1 Start Here



Contents

Installing Hyperion Essbase Release 6.1 . . . . . . . . . . . . .4

Installation Roadmap . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

Migrating from Release 6.0 . . . . . . . . . . . . . . . . . . . . . . .9

Migrating from Release 5.x . . . . . . . . . . . . . . . . . . . . . . .9

Migrating Hyperion Essbase Between Computers  . . . .18

Migrating from 16-bit to 32-bit Lotus 1-2-3 
Spreadsheet Add-in  . . . . . . . . . . . . . . . . . . . . . . . . . . . .20

Platform Support and Hardware Requirements . . . . . . .23

Where to Get More Information  . . . . . . . . . . . . . . . . . .28
●3Hyperion Essbase Release 6.1 Start Here



Installing Hyperion Essbase Release 6.1
If you are a new user, see “Installation Roadmap” on page 7. For detailed installation 
information, see the Hyperion Essbase Installation Guide. For platform information, 
see “Platform Support and Hardware Requirements” on page 23.

What’s Changed in the Installation
Please note the following installation and platform-related changes implemented for 
Release 6.1.

Default Installation Directory
The default directory for new installations is C:\HYPERION\ESSBASE 
(/home/hyperion/essbase on UNIX). Formerly, the default directory was 
C:\ESSBASE (/home/essbase on UNIX). If you are installing on a computer that 
already has Hyperion Essbase software installed, the default directory will be 
whatever is specified in your existing $ARBORPATH environment variable.

Automatic MaxL Installation
Upon installation of Release 6.1, MaxL is automatically installed to the bin directory. 
To launch the MaxL Command Shell, type essmsh at the operating-system command 
prompt. MaxL documentation is installed to the Docs\Techref\MaxL directory 
(docs/techref/maxl on UNIX). To launch the MaxL documentation, open 
maxlref.htm in your Web browser.

For more information, refer to the Hyperion Essbase Installation Guide.

Java Installation on Windows Systems
When you install Hyperion Essbase, you can include Java™ as part of the installation. In 
Release 6.1, using custom-defined macros and custom-defined functions requires Java. 
If you choose not to install Java, custom-defined macros and functions are not enabled.
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Java Installation on UNIX Systems
In Release 6.1, Java is required for using custom-defined macros and custom-defined 
functions. On UNIX systems you are not given the option of installing Java. You must 
manually install the Java. For information about installing Java on UNIX systems, see 
the Hyperion Essbase Installation Guide.

SQL Interface Installation Changes
Hyperion Essbase Release 6.1 provides version 3.6 of the MERANT-branded ODBC 
drivers and a sample odbc.ini file to support new versions of Oracle and DB2 while 
dropping support for older versions. Formerly, version 3.11 was provided with Release 
6.0 and versions 3.02 and 3.10 were provided with Release 5.x. 

Instead of providing DB2 bnd files as was done with previous versions, DB2 users can 
use the native IBM ODBC provided with the DB2 client.

Hyperion Essbase does not install the GlobalC files under the dlls/locale directory 
in Release 6.1. These files are installed in the $ARBORPATH/locale directory for all 
platforms.

Sample Custom-Defined Functions
Release 6.1 of Hyperion Essbase automatically installs sample custom-defined functions 
(CDFs) as a Java class called Statistics, which is in a Java Archive (.jar) file. Refer to the 
online Technical Reference in the DOCS directory for documentation about these sample 
functions.

Hyperion Essbase Toolbar
The esstoolb.xls file, which contains the Hyperion Essbase Spreadsheet Add-in 
toolbar for Excel, has been updated with a new toolbar without the button for the obsolete 
feature, SQL Drill-Through. 

You need to replace the toolbar in Excel only if you have an existing Hyperion Essbase 
toolbar installed. If this is your first Hyperion Essbase installation, you must open 
esstoolb.xls one time to install the Hyperion Essbase toolbar, as stated in the 
Hyperion Essbase Installation Guide and Hyperion Essbase Spreadsheet Add-in User’s 
Guide for Excel.
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Use the following steps to replace the old toolbar with the new one:

1. Open Excel.

2. Select View > Toolbars > Customize.

3. In the Customize dialog box, scroll down the list and select Hyperion Essbase.

4. Click Delete. A dialog box is displayed to confirm deletion of the Hyperion Essbase 
toolbar. 

5. Click OK.

6. In the Customize dialog box, click Close.

7. To open the spreadsheet containing the new toolbar, select File > Open.

8. In the Open dialog box, navigate to the directory where esstoolb.xls is installed. 
The default directory is C:\Hyperion\Essbase\client\sample.

9. Select esstoolb.xls and click Open. A dialog box is displayed, indicating that the file 
contains macros.

10. Click Enable Macros. The Hyperion Essbase toolbar without the SQL 
Drill-Through button is displayed in Excel. The next time you open Excel, you will 
see this toolbar.

To check that you have the correct version of the Hyperion Essbase toolbar, select 
View > Toolbars. A toolbar named Hyperion Essbase is displayed in the list.

System Files Installed
With client installations, Microsoft files and libraries are added to the system directory if 
they do not already exist. See “Windows System File Updates” on page 26 for more 
information.

Uninstalling Hyperion Essbase
You can now uninstall Hyperion Essbase from Windows platforms using the 
Add/Remove Programs icon in the Control Panel. Hyperion Essbase components (for 
example, Application Manager, the Windows NT server, and Spreadsheet Add-ins) must 
be uninstalled individually.
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Installation Roadmap
This section provides an overview of the steps required to set up the environment, 
communications, and Hyperion Essbase software. For detailed installation information, 
see the Hyperion Essbase Installation Guide.

Preparing for Installation of Release 6.1
Hyperion Essbase Application Manager, Hyperion Essbase Spreadsheet Add-in, and the 
Runtime Client on Windows platforms include the ability to install the client software 
from a network drive. You install a master copy to the network drive and then each client 
user installs from the master copy. You can run the client software from either a local 
hard disk or from the network drive. 

Installation preparation for Release 6.1 includes the following steps:

1. Set up a server computer with minimum hardware requirements as described in the 
Hyperion Essbase Installation Guide.

2. Install and establish network communications software on the server computer.

3. Configure the Windows client computer as described in the Hyperion Essbase 
Installation Guide.

4. Install and establish network communications software on the client.

5. Independent of Hyperion Essbase, ensure that the client can communicate with the 
server. (For example, issue the Ping command under TCP/IP.)

6. Be sure to install Hyperion Essbase to a directory path that does not contain spaces. 
For example, specifying C:\Program Files\Essbase may cause problems when 
you run the software.

7. When installing Hyperion Essbase on a Windows platform, be sure to specify a 
directory name that has a maximum of 8 alphanumeric characters for the name 
(for example,\ESSBASE\61). For example, \ESSBASE\6.1.0 is a directory name 
that may cause problems.
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Steps for Installing Hyperion Essbase 
OLAP Server 
Installing the Hyperion Essbase OLAP Server software involves three main steps:

1. Install Hyperion Essbase OLAP Server software and sample applications, 

2. Define the default Hyperion Essbase System Supervisor name and password.

3. Install Hyperion Essbase SQL Interface for the server, if applicable to your license.

See the Hyperion Essbase Installation Guide for more detailed installation instructions.

Steps for Installing Hyperion Essbase Client 
The following steps highlight the major stages in installing Hyperion Essbase on a 
Windows-based client computer.

1. Install Hyperion Essbase Application Manager on the Windows client computer. 
(If the system administrator has installed a master copy to the network drive, you 
can install from the network using this master copy.)

2. Connect to the Hyperion Essbase OLAP Server using the default Hyperion Essbase 
System Supervisor name and password.

3. Load data into the sample applications. 

4. Add other user names and passwords.

5. Install the Hyperion Essbase Spreadsheet Add-in on the client computer.

Note: Hyperion Essbase Spreadsheet Add-in does not support multiple instances 
of Excel.

6. Connect to Hyperion Essbase OLAP Server and the Sample Basic database. 

7. Retrieve data from the sample applications. 

See the Hyperion Essbase Installation Guide for more detailed installation instructions.
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Migrating from Release 6.0
To upgrade from Release 6.0, you may install with the previous settings using a one-click 
installation feature. There are no data compatibility issues when migrating from Release 
6.0 to Release 6.1.

Migrating from Release 5.x 
This section describes compatibility between Release 6.1 and previous 5.x releases of 
Hyperion Essbase. For additional migration information, see “What’s Changed in the 
Installation” on page 4.

CAUTION: If you are installing over a previous release of Hyperion Essbase, your old 
Sample Basic will be overwritten. If you wish to keep the old release, you must rename it 
first.

Before you install Release 6.1, back up all Hyperion Essbase Release 5.x files. You can 
then revert to Release 5.x if you have problems. 

Please note the following installation and platform-related changes implemented after 
Release 5.x.
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Sample Hyperion Essbase Spreadsheet 
Add-in Files
Sample Hyperion Essbase Spreadsheet Add-in files with the file extension .wk4, 
now have the file extension .123, to match the file extensions of 32-bit Lotus 1-2-3. 
The sample Hyperion Integration Server Drill-Through files, Essdt.xls and 
Essdt.123, have replaced Dtreport.xls and Dtreport.wk4, respectively.

Cache Memory Locking Installation Requirements
For information on direct I/O and no-wait I/O, see Chapter 40 of the Hyperion Essbase 
OLAP Server Database Administrator’s Guide. For information on enabling or disabling 
Cache Memory Locking, see Chapter 41 of the Hyperion Essbase OLAP Server 
Database Administrator’s Guide.

Platform Direct I/O No-Wait I/O
Cache Memory 
Locking

Windows 95 Not supported Not supported Not supported

Windows 98 Not supported Not supported Not supported

Windows 2000 Supported Supported Supported1

1. On Windows NT and Windows 2000, the Hyperion Essbase Agent must be started by an 
administrator or power user to enable Cache Memory Locking (optional). Specifically, a power 
user is one who can run processes with the SE_INC_BASE_PRIORITY_NAME privilege 
set.

Windows NT Supported Supported Supported1

AIX Supported Not supported Not supported

Solaris Supported Not supported Supported2

2. After the server software is installed, the root user must run a script, root.sh to enable Cache 
Memory Locking (optional). For more information, see “Release 6.1 UNIX Server Installation 
Changes” on page 11.

HP-UX Supported3

3. Direct I/O not supported on HFS on HP-UX.

Supported Not supported
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Outline Synchronization Installation Requirements
To use this release for outline synchronization, you must:

● Delete existing.chg files from all Hyperion Essbase server computers.

● Install this release on all server computers sharing partitions, and on any client 
computers used for outline synchronization editing.

Release 6.1 UNIX Server Installation Changes
As of Release 6.0, you are not required to install and run Hyperion Essbase from an 
account called arbor. Any user can install, but this user must be the person who starts 
Hyperion Essbase. 

After installing Hyperion Essbase on Solaris, you can take advantage of the Cache 
Memory Locking feature by running the Bourne shell script, root.sh, from the root 
account. The script is located in $ARBORPATH/bin. This sets the server to run in 
Superuser mode so it can lock memory. If you choose not to run this script, Cache 
Memory Locking will not be enabled. 

To run root.sh, log in as user root, and enter the following commands:

$ su - 

Password: (enter your password) 
# cd /home/hyperion/essbase/bin 
# sh root.sh 
# exit
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Compatibility Between Client and Server
Hyperion Essbase OLAP Server Release 6.1 provides backward compatibility with 
Release 5.0 clients. This includes Hyperion Essbase Application Manager as well as 
Hyperion Essbase Spreadsheet Add-in.

Hyperion Essbase Application Manager releases prior to Release 5.0 do not work with 
the Release 6.1 server, and this combination is not supported. Hyperion Essbase 
Spreadsheet Add-in releases prior to 5.0 may work with the Release 6.1 server, but this 
combination also is not supported.

Because a Release 5.0 client lacks many features of a Release 6.1 client, you should 
upgrade to Release 6.1 clients when you upgrade to the Release 6.1 server. 

If you need to phase your upgrades, use the following order:

1. Install the Release 6.1 server and Hyperion Essbase Application Manager.

2. Install the Release 6.1 Hyperion Essbase Spreadsheet Add-in.

Combining pre-Release 6.0 servers with Release 6.1 clients is not recommended and is 
not supported.

More information: Hyperion Essbase OLAP Server Database Administrator’s Guide, 
Hyperion Essbase Spreadsheet Add-in User’s Guide for Excel or Hyperion Essbase 
Spreadsheet Add-in User’s Guide for 1-2-3.
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Migrating Databases: Release 5.x to Release 6.1
The next sections tell you how to migrate databases from Hyperion Essbase Release 5.x 
to Release 6.1

Release 5.x Files That Migrate
This section lists the files that migrate for each database. The following files migrate 
from Release 5.x to Release 6.1 files of the same name:

The dbname.TCT file does not need migration because its format has not changed from 
Release 5.x to Release 6.x.

When Does Hyperion Essbase Migrate the Files?
When Hyperion Essbase migrates databases depends on whether you specified “Allow 
Database to Start” and “Start When Application Starts” in the Database Settings dialog 
box, or in ESSCMD (SETDBSTATE). This section assumes that you set your database 
to start when its application starts. The Hyperion Essbase kernel checks for the presence 
of files resulting from previous unsuccessful migrations, restarting the migration process 
if necessary.

Hyperion Essbase migrates the ESSxxxxx.IND, ESSxxxx.PAG, and the dbname.ESM 
files when you start the application containing the database dbname. After these files 
are migrated, they are not backward-compatible with Release 5.x.

Steps for Migrating Applications and Databases
After migration, you can restore Hyperion Essbase Release 5.x databases only by 
restoring from backups. Therefore, it is important to back up Release 5.x databases 
before starting the migration process.

To migrate, proceed in the following order for each database:

1. Run the VALIDATE command in ESSCMD against the Release 5.x database. 
VALIDATE prompts you to specify a name for the error log file that it will use.

If VALIDATE returns errors, revert to a backup that is free of those errors. 

2. Back up all application files, database files, and the security file.

ESSxxxxx.IND Index file
ESSxxxx.PAG Data File
dbname.ESM Persistent database root file
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3. If you are using LROs in a production environment, run the 
LISTLINKEDOBJECTS command in ESSCMD before migrating to Release 6.1. 
The LISTLINKEDOBJECTS command returns a list of LROs contained in the 
databases. In Release 6.1, the VALIDATE command checks specifically for LRO 
errors, and you may need information on LROs after migrating. 

4. Stop the Hyperion Essbase OLAP Server, if it is running.

5. Install Hyperion Essbase OLAP Server Release 6.1 to the same ESSBASE directory 
as the Release 5.x Hyperion Essbase installation.

6. Start the Hyperion Essbase Agent (ESSBASE.EXE ). 

If you want to change database settings, this is a convenient point at which to do so. 
If you change the settings now, you will not have to restart the database to make the 
settings effective. See “Database Settings Migration” on page 15 for information on 
the default settings.

7. Select a database or load an application. The server migrates the files listed in 
“Release 5.x Files That Migrate” on page 13. 

8. Run the VALIDATE command in ESSCMD against the Release 6.1 database. 
VALIDATE prompts you to specify a name for the error log file that it will use.

9. If VALIDATE returns only LRO-related errors to the log file after migration, you 
must restore data from a Release 5.x backup and re-create the LROs:

a. Either restore data from a backup of the database that does not contain LROs, 
or reload from a database export.

b. Restart the database in Hyperion Essbase Release 6.1. 

Hyperion Essbase migrates the database to Release 6.1 format if the database 
was restored.

c. Run the VALIDATE command.

d. Re-create the LROs, using the information from the LISTLINKEDOBJECTS 
output as a guide. You may need to review the output from 
LISTLINKEDOBJECTS manually to verify its completeness.

10. Upon successful completion, unload the database and then back up the Release 6.1 
database files.
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Database Settings Migration

CAUTION: Memory requirements for Release 6.x Hyperion Essbase databases have 
changed from prior releases. 

In previous releases of Hyperion Essbase, the file system for the operating system cached 
the index files and data files (page files). The file system cache itself used a great deal of 
memory. In Hyperion Essbase Releases 6.0 and 6.1, Hyperion Essbase caches the index 
files and data files using the index cache and an important new cache, the data file cache. 
Because Hyperion Essbase now caches the index and data files, the memory previously 
allocated by the file system to the file system cache must now be allocated to the 
Hyperion Essbase caches to maintain or improve performance. 

Note: Because the index cache and the data file cache are specific to a database, if you 
are running multiple databases concurrently on a server, your memory requirements may 
increase substantially.

Note: On Windows NT with NTFS only: to obtain accurate index and data file size 
information, use Application Manager or the LISTFILES ESSCMD command. The index 
and data file size information provided by the Windows NT operating system may be 
inaccurate.

For information on estimating the memory and disk requirements for each of your 
databases, see the Hyperion Essbase OLAP Server Database Administrator’s Guide 
(Chapter 15, “Estimating Disk and Memory Requirements for a Database”).

All Hyperion Essbase Release 6.1 database settings, except the cache sizes, retain their 
Release 5.x values. For example, if you had Bitmap Compression enabled in Release 5.x 
as the Data Compression Type, Bitmap Compression is enabled automatically in Release
6.1 after migration. If you did not specify a value for a particular setting in Release 5.x, 
the default value is used in Release 6.1. For more information on database settings, see 
the Hyperion Essbase OLAP Server Database Administrator’s Guide.

The following table shows the cache settings, listed in priority order from highest 
priority to lowest priority. For example, allocating adequate memory to the index cache 
is top priority, followed by the index page, the data file cache, and so on. To override the 
migration defaults, before you start the database, use SetDbStateItem in ESSCMD or 
select Database > Settings in the Application Manager.
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Cache 
Settings 
in priority 
order

Minimum 
Value Default Value

Release 6.1 
Migration Default Recommended Value

Index 
Cache 
Size

1 Megabyte =
1048576 bytes

10 Megabyte =
10485760 
bytes1 

If the current value is less 
than the default value, then 
it is replaced by the default 
value; otherwise, the 
current value is retained.

Combined size of all ESS*.IND files if 
possible; as large as possible otherwise.

Index 
Page Size

1 Kilobyte =
1024 bytes

8 Kilobytes = 
8192 bytes with 
Direct I/O; 

1 Kilobyte =
1024 bytes 
Buffered I/O

When Direct I/O is in 
effect, Hyperion Essbase 
ignores the Index Page Size 
setting and always employs 
an Index Page Size of 8 
Kilobytes. If Buffered I/O is 
in effect, the current value 
is used.

When Direct I/O is in effect, Hyperion 
Essbase ignores the Index Page Size 
setting and always employs an Index 
Page Size of 8 Kilobytes. If Buffered 
I/O is in effect, then use the same value 
that you were using with pre-Release 
6.x versions of Hyperion Essbase.

Data File 
Cache 
Size

8 Megabytes =
8388608 bytes

32 Megabytes =
33554432 
bytes1

Default value is used. Combined size of all ESS*.PAG files if 
possible; as large as possible otherwise.

Data 
Cache 
Size

3 Megabytes =
3145728 bytes

3 Megabytes =
3145728 bytes1 

If the current value is less 
than the default value, it is 
replaced by the default 
value; otherwise, the 
current value is retained.

0.125 * Data File Cache Size value.

Note: Certain calculations require a 
larger Data Cache Size in Release 6.x.

In general, if you have to choose 
between allocating memory to the Data 
File Cache or allocating it to the Data 
Cache, choose the Data File Cache.

Cache 
Memory 
Locking

Not applicable Disabled Disabled If you want to give Hyperion Essbase 
Kernel priority usage of the system 
RAM, enable Cache Memory Locking, 
being careful to leave at least one third 
of the system RAM for non-Hyperion 
Essbase Kernel use. Otherwise, disable 
Cache Memory Locking.

1. To specify a different default value for all newly created databases, use the ESSBASE.CFG file settings INDEXCACHESIZE, 
DATAFILECACHESIZE or DATACACHESIZE. For more information, see the online Technical Reference in the DOCS 
directory.
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Sample Basic Outline Migration
The Sample Basic outline has changed to reflect attribute-related features. The outline 
contains five new attribute dimensions and a new member, Profit per Ounce, in the 
Scenario dimension. If you are upgrading to Release 6.1, you must clear existing data 
from Sample Basic and reload from CALCDAT.TXT after installing the Release 6.1 server 
and sample applications.

Opening Retrieval Wizard Files in Query Designer
Hyperion Essbase Query Designer (EQD) replaces Retrieval Wizard for creating queries. 
If you have Retrieval Wizard (.WIZ) files, the EQD may not properly translate Retrieval 
Wizard subsets to EQD member filters, which could cause the following problems. 

● The EQD does not interpret parentheses within the subsets. It ignores them.

● When the subset contains both AND and OR conditions, with or without 
parentheses, the EQD may not group the conditions to be processed as you 
expect them. This can affect the result of the retrieval. 

After opening Retrieval Wizard files, make sure the nodes in the navigation panel define 
the member filters as you want them. If necessary, you can manually promote, demote, 
or move nodes around or add new nodes.

For example, the following subset from the Retrieval Wizard, 

(Flavor is Apple AND Container is glass) OR Flavor is Grape

will be interpreted in the EQD as:

|__Flavor is Apple

|__Container is Glass

|__Flavor is Grape

You need to change the member filters in the EQD to:

|__Flavor is Apple

|__Container is Glass

|__Flavor is Grape
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Migrating Hyperion Essbase Between Computers
➤ To move Hyperion Essbase Release 6.1 to a different computer, or to migrate 

Hyperion Essbase to Release 6.1 on a different computer, follow these steps:

1. Run the VALIDATE command in ESSCMD against the database you are migrating. 
VALIDATE prompts you to specify a name for the error log file that it will use.

If VALIDATE returns errors, revert to a backup that is free of those errors. 

2. Back up the security file (ESSBASE.SEC). 

3. Back up all application and database files on the original server (that is, the server 
from which you are migrating).

4. Install Hyperion Essbase on the new server computer. If you are migrating to a newer 
version of Hyperion Essbase, install that version to the new server. See the Hyperion 
Essbase Installation Guide for more information.

5. Copy the ESSBASE.CFG file from the ESSBASE\BIN directory on the original server 
to the same directory on the new server using the file system.

6. On the new server, define your disk volumes. To allocate a new volume, place 
SETDBSTATEITEM 23 in the ESSBASE.CFG file and follow the prompts. You can 
also use the Database Settings dialog box in Application Manager or the alter 
database statement in MaxL.

Consider carefully how you configure your disk volumes. Any changes you make to 
your SETDBSTATEITEM setting after you have loaded data on the new server are 
reflected only in new data loads; changes are not retroactive. For information on 
SETDBSTATEITEM, see the Hyperion Essbase OLAP Server Database 
Administrator’s Guide and the online Technical Reference in the DOCS directory.

7. Using Application Manager or ESSCMD, create new applications and databases on 
the new server. 

The names of the applications and database you create do not need to be the same as 
the ones on the original server. However, if you make changes to the names, make 
sure that these changes are reflected in script files, spreadsheet macros, and 
API-based applications. In addition, make sure that these changes are clearly 
communicated to the user base.

CAUTION: Do not move the application directory to the new server though a file 
transfer via the operating system or via FTP. 

8. On a client or server computer that has connectivity to both the original and new 
Hyperion Essbase servers, open Application Manager.
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9. Select File > Open, click Client, and select the original server, application, and 
database.

10. Open the original outline (.OTL ) file, and select File > Save As.

11. Save the.OTL file to the new application and database on the new server. 

At this point, you should avoid making changes to the outline if you want to be able 
to import the data file that you will export from the original application. 

12. Move all calc scripts, rules files, and report scripts to the new server using one of the 
following procedures:

● Repeat steps 6–9 of this procedure. 

● Move the files to the new server via the file system or via FTP.

If you are migrating between different server platforms, be sure to use the procedure 
described in steps 6–9 of this procedure. If you are migrating between the same 
server platforms, calc script and report script files can be moved using the operating 
system. If you move these files via the operating system, check to make sure that they 
function properly after moving them. 

CAUTION: Data load rules files are binary files and should always be migrated as 
described in steps 6–9.

13. Export data from the application on the original server in one of the following ways:

● Choose All Data, Input Level Data, or 0 Level Data, depending on the size of 
your data set as well as how the database was initially loaded.

● Use the initial data load files that were used to populate the database on the 
original server.

14. Import data to the new application on the new server. 

15. Recalculate your database if:

● You loaded input-level data from data load files, or 

● You exported only partial data from the database (for example, if you chose 
“0 Level” or “Input Level” data only) 

16. Repeat these steps for all other databases on the original server that you want to 
migrate to the new server.

17. Migrate security information by recreating user filters, groups, and permissions on 
the new server.

CAUTION: If you move the security file (ESSBASE.SEC and its backup 
ESSBASE.BAK) between computers, it may not work properly. 
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Migrating from 16-bit to 32-bit Lotus 1-2-3 
Spreadsheet Add-in

Because of differences between 16-bit and 32-bit releases of Lotus 1-2-3, you must 
migrate workbooks that contain Hyperion Essbase macros so that your existing macros 
work properly with 32-bit Lotus 1-2-3. For more information on macro differences 
between these two releases, see the Lotus 1-2-3 documentation.

Specifying Optional Parameters
You must now specify information for all optional parameters for macros. For example, 
the syntax for the EssRetrieve macro is:

{EssRetrieve sheetName, range, lock, statusCell}

where sheetName, range, lock, and statusCell are optional parameters.

You must now specify information for each parameter. If you leave any parameters of a 
macro blank or enter invalid syntax, the macro will fail and may produce unpredictable 
behavior. 

Using NULL as a Parameter

Instead of entering a specific parameter for each macro, you can enter NULL as a 
parameter to implement active sheets, cells, and so forth. For example, with the 
EssZoomIn macro, the syntax is:

{EssZoomIn sheetName, range, selection, level, across, statusCell}

In previous versions of this macro, you could enter a comma in place of a parameter in 
order to use, for example, an active sheet or cell. Hyperion Essbase would have returned 
information for the current sheet or cell. You must now enter either a specific parameter 
or NULL in order for the macro to work. For example:

{EssZoomIn NULL, A1..E6, A2, 1, 0, NULL}

where the first NULL tells Hyperion Essbase to use the currently active sheet, and the 
last NULL indicates that you do not wish to have the error code displayed.
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SheetName Parameter
When you specify a workbook file name for the sheetName parameter, you must now 
specify the entire directory path or use NULL as the parameter. For example, the 
following example would no longer be valid syntax for the EssCalculate macro:

{EssCalculate <<SAMPLE.123>>A,Calc2,0,H6}

In this example, you would need to specify the entire path for <<SAMPLE.123>> 
(or use NULL to use the active sheet). For example:

{EssCalculate <<C:\ESSBASE\CLIENT\SAMPLE\SAMPLE.123>>A,Calc2,0,H6}

or

{EssCalculate NULL,Calc2,0,H6}

You can also enter a default Lotus 1-2-3 sheet name (such as A, B, C) instead of 
specifying a file name or using NULL for the sheetName parameter. For example:

{EssCalculate A,Calc2,0,H6}

In this case, Hyperion Essbase would use sheet “A” from the active workbook.

Sheet Macros that Call Hyperion Essbase 
Functions
To call Hyperion Essbase functions from the sheet, you must use the Lotus 1-2-3 LET 
command. Sheet macros that call Hyperion Essbase functions require: 

● the LET command followed by the cell reference

● the @ sign before the function 

● parentheses around the parameters 

● quotations marks ("") around string arguments

For example:

{LET H38,@EssCell ("Year","100-10","NULL","NULL","NULL","NULL",
"NULL","NULL","NULL","NULL","NULL",
"NULL","NULL","NULL","NULL")}

Note: The LET command is explained in the Lotus 1-2-3 documentation.

Note: You must place quotation marks around all string arguments and NULL. Do 
not place quotation marks around numeric parameters (for example, 1), but do place 
quotation marks around numeric member names (for example, “100-10”).
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On the other hand, Hyperion Essbase macros do not work with parentheses and do not 
require quotation marks around strings. For example: 

{EssRetrieve NULL,<<SAMPLE.123>>A:A1..G20,2,H6}

Modified or Deleted Macros
The following macros have been modified or deleted:

● EssSetShOption Macro—The EssSetShOption macro includes a new parameter, 
statusCell. See the Hyperion Essbase Spreadsheet Add-in Help for the new syntax 
for this macro.

● EssSetSheetOpt Macro—The EssSetSheetOpt macro will no longer be updated after 
Hyperion Essbase Release 5. Use the EssSetShOption macro to set individual 
spreadsheet options.

● EssSetGlobalOpt Macro—The EssSetGlobalOpt macro will no longer be updated 
after Hyperion Essbase Release 5. Use the EssSetGlobalOption macro to set 
individual spreadsheet options.

● EssCell Function—The syntax for the EssCell function has changed. See the 
Hyperion Essbase Spreadsheet Add-in Help for the new syntax for this macro.
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Platform Support and Hardware Requirements
Hyperion Essbase Release 6.1 supports the following server and client platforms. Except 
where noted, these are minimum requirements.

Note: Windows NT 3.5.1 is no longer a supported platform.

 

Server Platforms

Windows Version Windows NT 4.0 on Pentium or better or equivalent computers 1 

Windows 2000 on Pentium or later computers

Windows 95B and Windows 98 on Pentium or better or equivalent computers 
(Personal Essbase only)

AIX Version 4.3.3 or higher on RS 6000 PowerPC computers

HP-UX Version 11.0 on PA-RISC computers. See Readme.txt for required patches.

Solaris Version 7 and 8 (SUN OS 5.6 and 5.7) on Sun SPARC or ULTRASPARC computers 

Red Hat Linux Version2 6.1 on Pentium or better or equivalent computers 

RAM 64 MB or greater (128 MB or greater for UNIX platforms) base recommendation 3 

Disk Space 26–50 MB for the server software and sample applications 

15–20 MB for the SQL Interface software and samples

Network Protocol TCP/IP or Named Pipes (TCP/IP only for Windows 95 and Windows 98)

JavaTM Platform Java Runtime Environment version 1.2.2 or later, 
Java API for XML Parsing version 1.01

1. Personal Essbase for Windows NT and Windows 2000 on Intel computers is also available.

2. Red Hat Linux Version is not supported in Hyperion Essbase Release 6.1.

3. The base recommendation for running Hyperion Essbase and its sample applications is a 64 MB minimum. On UNIX 
platforms, base requirement is 128 MB of physical memory (256 MB recommended), and at least twice the MB of physical 
memory for swap space (when physical memory is less than .5 GB). Contact your system administrator or hardware vendor 
for optimum swap configuration.

Note: Start with the base amount of RAM for your platform, and then allocate additional memory to accommodate your 
applications.
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Client Platforms

Microprocessor Pentium or better or equivalent, for Hyperion Essbase Spreadsheet Add-in and Hyperion 
Essbase Application Manager

Windows Version Windows 95B, Windows 98, Windows NT 4.0, or Windows 2000.

Excel Version Excel 97, Excel 2000

Lotus 1-2-3 Version Lotus 1-2-3 Millennium Releases 9.1 and 9.5

Display Resolution of at least 640 x 480 (800 x 600 or more recommended)

RAM 16 MB for Hyperion Essbase Spreadsheet Add-in and Application Manager on Windows 95, 
Windows 98, Windows NT 4.0, or Windows 2000

Disk Space 24 MB for Hyperion Essbase Application Manager

17.5 MB for Hyperion Essbase Spreadsheet Add-in for 1-2-3

16.7 MB for Hyperion Essbase Spreadsheet Add-in for Excel

9 MB for Hyperion Essbase Runtime Client

Network Protocol TCP/IP or Named Pipes 

API Client Development Platforms

Windows Version Windows 95 or 98 on Pentium or better or equivalent computers

Windows NT 4.0 on Pentium or better or equivalent computers

Windows 2000 on Pentium or better or equivalent computers

AIX Version 4.3.3 or higher on RS 6000 PowerPC computers

HP-UX Version 11.0 on PA-RISC computers 

Solaris Version 7 and 8 (Sun OS 5.7 and 5.8) on Sun SPARC or ULTRASPARC computers

RAM Same as for server platforms

Disk Space 15 MB for 32-bit Hyperion Essbase API on Windows NT, Windows 95, Windows 98, 
or Windows 2000 on Pentium

5 MB for AIX 
6 MB for HP-UX 
6 MB for Solaris   
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SQL Source Connectivity

Supported ODBC Drivers
MERANT ODBC driver version 3.6 is provided with Hyperion Essbase Release 6.1 SQL 
Interface. However, Hyperion Solutions also tests and supports some non-MERANT 
Windows NT drivers. These non-MERANT drivers are not provided with SQL Interface. 
Hyperion Solutions has tested the following database configurations. This table applies 
only to Release 6.1.

Check http:\\www.essbase.com for the latest information regarding ODBC drivers.

Database Server 
(Database Client)

Windows NT 
4.01/Windows 
2000

Solaris7/8 
Sun OS 5.7/5.8 AIX 4.3 HP-UX 11.02

DB2 UDB 6.1 DB2 6.1 ODBC DB2 6.1 ODBC DB2 6.1 ODBC DB2 6.1 ODBC

DB2 UDB 7.1 DB2 7.1 ODBC DB2 7.1 ODBC DB2 7.1 ODBC DB2 7.1 ODBC

Informix ESQL /c 9.x MERANT 3.6 MERANT 3.6 MERANT 3.6 MERANT 3.6

Oracle 8.04 
(SQL*Net 8.0)

MERANT 3.6 MERANT 3.6 MERANT 3.6 MERANT 3.6

Oracle 8i 
(SQL*Net 8.0)

MERANT 3.6

Oracle 8i ODBC

MERANT 3.6 MERANT 3.6 MERANT 3.6

MS SQL Server 6.5.201 
(no Client required)

MS SQL Server 6.5 
ODBC

Not tested Not tested Not tested

MS SQL Server 7.0 
(no Client required)

MS SQL Server 7.0 
ODBC

Microsoft Driver 

Not tested Not tested Not tested

Sybase 11.x MERANT 3.6 MERANT 3.6 MERANT 3.6 MERANT 3.6

Access 97 Microsoft Driver Not available Not available Not available

1. Not tested.

2. MERANT 3.6 ODBC drivers are supported only on HP-UX computers using 32-bit relational database client software.
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Windows System File Updates
On Windows NT 4.0, Windows 2000, Windows 95, Windows 98, and Windows 
Millennium, the installation program updates the client or server system environment to 
run Hyperion Essbase Release 6.1 software. Microsoft system files are installed to the 
Windows system directory (for example, C:\Windows\System on Windows 95, or 
C:\Winnt\System32 on Windows NT 4.0) if the files do not already exist, or if the 
version shipped with Hyperion Essbase is newer.

The following table lists Windows system files installed with each Hyperion Essbase 
component. A check mark in a column indicates that the system file is installed with the 
specified Hyperion Essbase component. These files will be installed to your system 
directory only if the files do not already exist, or if older versions exist.

File
Windows 
Servers

Application 
Manager

Excel 
Add-in 

1-2-3 
Add-in

Runtime 
Client API

SQL 
Interface File Version

ATL.DLL ✔ ✔ 2.00.7024

CTL3D32.DLL ✔ 2.31.000

MFC42.DLL ✔ ✔ ✔ 4.21.7022 1 

MSVCRT.DLL ✔ ✔ ✔ ✔ 5.00.7022 2 

MSVCIRT.DLL ✔ ✔ ✔ ✔ 5.00.7022

MTXDM.DLL ✔ 1997.11.532.0

1. Do not use file versions 6.00 through 6.00.8336, as these file versions may cause memory allocation problems.

2. Do not use file versions 6.00 through 6.00.8266, as these file versions may cause memory allocation problems.
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Where to Get More Information

Except for late-breaking news and migration 
information, each topic in this booklet is described 
in more detail in the documentation.

For information on new features and documentation, 
see the Hyperion Essbase New Features booklet.

For answers or comments on technical 
documentation:

Hyperion Essbase Technical Publications 
Phone: 408-744-9500 
FAX: 408-744-0400 
E-mail: TechPubs@hyperion.com 

For answers to technical questions on the product, 
performance, and platform specifics, contact your 
authorized technical support provider or:

Hyperion Essbase Client Support 
Phone: 877-901-HYSL in North America
E-mail: client_support@hyperion.com
Internet: http://support.hyperion.com

Clients in Europe, Asia, or other areas should call 
their local support phone number.

Visit the Hyperion Solutions Web Site Home Page at 
http://www.hyperion.com 

© 1991–2000 Hyperion Solutions Corporation. 
All rights reserved.

U.S. Patent Number: 5,359,724

Hyperion and Essbase are registered trademarks, and 
Hyperion Solutions is a trademark of Hyperion Solutions 
Corporation.

Microsoft is a registered trademark, and Windows is a 
trademark of Microsoft Corporation. IBM, DB2, Lotus, 
and 1-2-3 are registered trademarks of IBM Corporation. 
Red Hat is a registered trademark of Red Hat, Inc. All other 
brand and product names are trademarks or registered 
trademarks of their respective holders.

No portion of this manual may be reproduced or transmitted 
in any form or by any means, electronic or mechanical, 
including photocopying, recording, or information storage 
and retrieval systems, for any purpose other than the 
purchaser’s personal use, without the express written 
permission of Hyperion Solutions Corporation.

Notice: The information contained in this document is 
subject to change without notice. Hyperion Solutions 
Corporation shall not be liable for errors contained herein 
or consequential damages in connection with the furnishing, 
performance, or use of this material.

Hyperion Solutions Corporation
1344 Crossman Avenue
Sunnyvale, CA 94089

Printed in the U.S.A.
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